
Expert4x theTradeableRSI
EA for MT4
November 18, 2020



Page ii

Contents

Copyright Notices............................................................................................... 4

Getting Started with the theTradeableRSI EA............................................... 5
2.1 Installing the theTradeableRSI EA......................................................................................................... 5
2.2 theTradeableRSI Expert Advisor  First Time Activation....................................................................... 8

System Requirements....................................................................................... 12
3.1 Operating System Requirements........................................................................................................... 12
3.2 Hardware Requirements.........................................................................................................................12
3.3 MetaTrader (MT4) Requirements and Settings.....................................................................................12
3.4 Forex Broker Requirements...................................................................................................................12
3.5 Hedging Support Requirements.............................................................................................................12
3.6 Non-FIFO Support Requirements......................................................................................................... 13
3.7 Account Type and Minimum Lot Size Requirements.......................................................................... 13

theTradeableRSI EA Configuration Guide................................................... 14
4.1 Configuration and Operation Principles................................................................................................14
4.2 theTradeableRSI EA Parameter Descriptions....................................................................................... 14

4.2.1 Combined Target Settings...................................................................................................... 15
Target Profit Amount......................................................................................................... 15
Target Profit Pips................................................................................................................15

4.2.2 Indicator And Trading Logic Settings....................................................................................16
BUY Leg Settings.............................................................................................................. 16
SELL Leg Settings............................................................................................................. 19
Custom Sell Setup.............................................................................................................. 20
Market Phase Settings........................................................................................................ 23

4.2.3 Common Settings....................................................................................................................25
Trade Limits........................................................................................................................25

4.2.4 Position Management..............................................................................................................26
Direction of Trade Entry.................................................................................................... 26
Initial SL for New Position................................................................................................27
Take Profit.......................................................................................................................... 27
Position Sizing.................................................................................................................... 27
Breakeven............................................................................................................................28
Trailing Stop....................................................................................................................... 29
Dynamic Stop..................................................................................................................... 29
Dynamic Target.................................................................................................................. 30

4.2.5 Day of Week & Time of Day Entry Filter.............................................................................. 31
Reference Time Selection...................................................................................................31
GMT Offset of Broker....................................................................................................... 32
Entry Window From Hour/Minute - Entry Window Until Hour/Minute........................... 33
Monday ... Sunday Trade Entry......................................................................................... 33

4.2.6 Operations Settings................................................................................................................. 34
Closeout Summary Text Colour.........................................................................................34
Tick Scaling for CFD Markets...........................................................................................34
Magic Number Parameter...................................................................................................36

Knowledgebase.................................................................................................. 37
5.1 How to Download MT4........................................................................................................................ 37



Page iii

5.2 How to Download the Setup Application............................................................................................. 37
5.3 How to Install the theTradeableRSI EA............................................................................................... 38
5.4 How to Upgrade the EA....................................................................................................................... 40
5.5 How to Attach the theTradeableRSI Expert Advisor  to a Chart......................................................... 41
5.6 How to Load Setfile from the Settings Analysis Site...........................................................................43
5.7 MetaViewer dll could not be found...................................................................................................... 45
5.8 theTradeableRSI Expert Advisor  First Time Activation..................................................................... 46
5.9 Sad Face Instead of Smiley Face After Attach.....................................................................................48
5.10 What is the Leverage of My Account.................................................................................................49
5.11 How to Figure Out My Broker's GMT Offset?.................................................................................. 50
5.12 EA Is Not Starting Up After Attach to Chart..................................................................................... 51
5.13 No Updates to Chart............................................................................................................................51
5.14 Prompted for Access ID at Service Access Settings...........................................................................52
5.15 How to Edit the EA Input Values.......................................................................................................53
5.16 Not Enough Memory For Bar History Or Indicator........................................................................... 53
5.17 No Trades Due to Trade Disabled...................................................................................................... 54
5.18 How to Load Setfile from the Settings Analysis Site for Backtesting................................................55
5.19 Backtest In Visual Mode Not Working.............................................................................................. 57
5.20 Backtest Not Working......................................................................................................................... 57
5.21 Connection Down Message................................................................................................................. 59
5.22 Suspended Message............................................................................................................................. 59
5.23 Computer Always-on...........................................................................................................................60
5.24 No Result in Optimization.................................................................................................................. 61
5.25 No Trades During Backtesting............................................................................................................62
5.26 Visual Mode Checkbox Missing in Strategy Tester........................................................................... 64
5.27 Step-by-step Installation of Expert4x EAs and Indicators.................................................................. 65
5.28 How to download an EA setup in VPS environment......................................................................... 71
5.29 How to enable JavaScript in your Internet Explorer...........................................................................83
5.30 How to Enable Download in your Internet Explorer..........................................................................85

Operational Messages.......................................................................................89
6.1 Operational Messages............................................................................................................................ 90

6.1.1 Message 1001......................................................................................................................... 91
6.1.2 Message 1002......................................................................................................................... 92
6.1.3 Message 1006......................................................................................................................... 92
6.1.4 Message 1007......................................................................................................................... 93
6.1.5 Message 1008......................................................................................................................... 94
6.1.6 Message 1017......................................................................................................................... 95
6.1.7 Message 1018......................................................................................................................... 95
6.1.8 Message 2118......................................................................................................................... 96
6.1.9 Message 2101......................................................................................................................... 97
6.1.10 Message 9104....................................................................................................................... 97

6.2 MetaTrader Operational Messages........................................................................................................ 98
6.2.1 MT4 Message 2...................................................................................................................... 99
6.2.2 MT4 Message 129.................................................................................................................. 99
6.2.3 MT4 Message 132................................................................................................................ 100
6.2.4 MT4 Message 133................................................................................................................ 101
6.2.5 MT4 Message 136................................................................................................................ 101
6.2.6 MT4 Message 148................................................................................................................ 102
6.2.7 MT4 Message 4024.............................................................................................................. 102

Support.............................................................................................................104

Index........................................................................................................................................ 105



Chapter

1
 Copyright Notices

Copyright©2020 – Expert4x, all rights reserved. This eBook is intended for the purchaser’s personal use only.
No part of this eBook may be reproduced or transmitted in any form whatsoever, electronic, or mechanical,
including photocopying, recording, or by any informational storage or retrieval system without expressed written
permission from Expert4x.

Copyright©2020 EAfactory, all rights reserved. All title, including but not limited to copyrights, in and to the
theTradeableRSI EA and any copies thereof are owned by EAfactory or its suppliers. All title and intellectual
property rights in and to the content which may be accessed through use of the theTradeableRSI EA is the
property of the respective content owner and may be protected by applicable copyright or other intellectual
property laws and treaties. All rights not expressly granted are reserved by EAfactory. For the full details please
refer to the End-User License Agreement ("EULA").
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2
 Getting Started with the theTradeableRSI EA

Getting Started provides a guided exploration of the theTradeableRSI EA. It is geared for an audience that has
little or no knowledge of installing an MT4 EA. It walks the novice user through downloading and installing the
theTradeableRSI EA.

2.1 Installing the theTradeableRSI EA
The theTradeableRSI EA comes with a setup application to provide a wizard based installation process to the
selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT4 terminal version 4.00 build 1280 or later installed.

1. Exit MT4 if it was running.

2. Log in to the Web Support Centre.

3. Scroll down and click on the theTradeableRSI EA in the Product List.

4. Click on the Product Download button to download the EA setup.

https://my.eafactory.com/expert4x
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5. Run the setup application. Select the MT4 instance during setup to where you want the service installed.

6. When setup completes start up MT4. The theTradeableRSI EA entry should appear under the Expert
Advisors node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.

The setup application lists the available MT4 instances. Select one of them for installation target and click on the
Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances. In this case use the
Add target directory... button to navigate and pick up the desired folder.
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C:\Program Files\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader installation. As a hint, the following
shows you the default path to the main MT4 directory for some brokers:

Broker Default Path

Blueberry Markets broker C:\Program Files (x86)\Blueberry Markets MetaTrader 4 Terminal

Dukascopy broker C:\Program Files (x86)\Dukascopy MetaTrader 4

IG broker C:\Program Files (x86)\IG MetaTrader 4 Terminal

OANDA broker C:\Program Files (x86)\OANDA - MetaTrader

Pepperstone broker C:\Program Files (x86)\Pepperstone MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its sub-directories.

When the installation is complete, start up MT4 and check that the EA appears in the Navigator window (View >
Navigator):
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So everything is set up for the first activation of the theTradeableRSI Expert Advisor  .

2.2 theTradeableRSI Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the theTradeableRSI Expert Advisor  in a few
steps.

Attach the EA to a chart

1. Drag & drop the theTradeableRSI Expert Advisor  from the Navigator window (View > Navigator) to a
chart window and select the Common tab:
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Note:

Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are ticked.

2. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the theTradeableRSI EA can be set up.
For more details see the theTradeableRSI EA Configuration Guide – for now click on the OK button and
let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

The theTradeableRSI EA is up and running

After successful authentication the theTradeableRSI EA starts up.

https://my.eafactory.com/expert4x
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The theTradeableRSI Expert Advisor  has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the theTradeableRSI Expert Advisor  was successful and the EA is now looking
for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase section.
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3
 System Requirements

Overview of prerequisites in order to install and get the product up and running.

3.1 Operating System Requirements
In order to operate the theTradeableRSI EA a Microsoft Windows operating system is required which supports
MetaQuotes MetaTrader version 4.00 platform.

Note that the MetaQuotes MetaTrader software is also known and often referred to as MT4.

3.2 Hardware Requirements
The minimum Random Access Memory (RAM) requirement is 512MB (0.5GB), however 1024MB (1GB) RAM
is recommended to avoid extended virtual memory usage. Note that this memory requirement is for MetaTrader
application only, excluding other applications running at the same time (e.g. MS Office). If other applications are
running parallel with MetaTrader application please increase the RAM requirement accordingly.

3.3 MetaTrader (MT4) Requirements and Settings
The EA is compatible with MetaQuotes MetaTrader platform version 4.00 build 1280 or higher. In general this is
referred to as MT4 terminal, build 1280 or newer.

3.4 Forex Broker Requirements
The theTradeableRSI EA is compatible with both 4 and 5-digit data feeds based brokers. The theTradeableRSI
EA automatically detects the type of the feed and adjusts the EA parameter pip values if and when necessary.

Both fixed and variable spread broker platforms are supported.

The selected MetaTrader based broker should allow keeping open orders on the account for long period of time,
i.e. the broker should not close and re-open orders over night for swap calculation, or should not merge open
orders for any reason.

IMPORTANT: For smooth trade management the MetaTrader application and the EA should be on-line, up and
running during all market open hours (usually Sunday to Friday).

3.5 Hedging Support Requirements
When the theTradeableRSI EA is attached to charts with both BUY and SELL trades enabled, the EA may keep
open BUY as well as SELL positions at the same time on the same market. In this situation the broker account
must support the hedging of trades.

Hedging support is not required only if the EA is attached to the market with either BUY or SELL enabled, but
never both at the same time.
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3.6 Non-FIFO Support Requirements
When the theTradeableRSI EA is attached to charts with both BUY and SELL trades enabled, or maximum
allowed open trades higher than 1 configuration, the EA may open and close positions out of order of the first-
in-first-out (FIFO) sequence. In this situation the broker account must support the order handling in non-FIFO
manner.

FIFO is supported only if the EA is attached to the market with either BUY or SELL enabled (never both at the
same time) and maximum allowed open trades is set to 1.

3.7 Account Type and Minimum Lot Size Requirements
A so-called Micro broker account is necessary if the available funds for the EA trading is less than approx. $1000.
The micro account allows the EA to open a position with minimum lot size of 0.01. If you plan to use a broker
account with the above funding please ensure that your broker account offers this minimum lot size.

An easy way to double check the minimum lot size available on the broker account is to attach the EA to a chart
and check the Market Info section on the chart:

The Lot line shows Min:0.01 which tells that the minimum lot size requirement is 0.01 on this broker account.
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4
 theTradeableRSI EA Configuration Guide

The theTradeableRSI EA configuration guide.

In order to activate the theTradeableRSI EA attach it to a chart window – for more details see theTradeableRSI
EA First Time Activation section.

4.1 Configuration and Operation Principles
The theTradeableRSI EA operational overview.

The theTradeableRSI EA manages only those tickets (a.k.a positions) on the account which belong to the
theTradeableRSI EA: every order submitted to the account is marked with the MagicNumber and, in return,
only those tickets on the account will be considered by the theTradeableRSI EA which are marked with this
MagicNumber.

In general it is recommended to run on an account one EA at a time. This helps understanding the ongoing trades
and troubleshoot situation if and when needed.

While this maybe feasible for demo accounts this may not be feasible for live accounts where there could be the
need to execute multiple expert advisors on the same account at the same time.

Using multiple expert advisors on the same account is only viable if each and all expert advisor will follow the
above MagicNumber principle and they manage only their own tickets on the account.

IMPORTANT: If you plan to use multiple expert advisors (other than the theTradeableRSI EA) on the
same account please ensure upfront with the expert advisor providers that their EA's are suitable for that
as per the above.

If you plan to use multiple theTradeableRSI EA's on the same account at the same time please ensure that the
MagicNumber is set to different and unique number for each chart of the same market.

Here are few examples:

Market MagicNumber

EURUSD chart 1 66000

EURUSD chart 2 66001

EURUSD chart 3 66002

GBPUSD chart 1 66010

GBPUSD chart 2 66011

GBPUSD chart 3 66012

USDCAD single chart EA default or any other

USDCHF single chart EA default or any other

4.2 theTradeableRSI EA Parameter Descriptions
The theTradeableRSI EA parameter descriptions.
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4.2.1 Combined Target Settings

 Target Profit Amount

Target Profit Amount

Combined profit target as an amount of account balance increase by the EA trades. The EA enters new trades
and closing them according to the Indicator And Trading Logic Settings and Position Management settings. The
very first entry marks the start of a 'run', which is a series of subsequent trades. Over time some of these trades
gets closed off, while the rest of them remain open. The sum of the profits of the closed trades plus the sum of
the profit or loss of the open trades gives the run's profit & loss amount. When the run's profit & loss reaches this
Target Profit Amount then the EA closes off all open trades and completes the run.

Example: I want the EA to close off all open trades when the aggregated profits of all currently open and so far
closed trades reaches the amount of $100.

Here is an EA configuration to achieve the above:

 1. Target Profit Amount = 100

 Target Profit Pips

Target Profit Pips

Combined profit target as pips achieved by the EA trades. The EA enters new trades and closing them according
to the Indicator And Trading Logic Settings and Position Management settings. The very first entry marks the
start of a 'run', which is a series of subsequent trades. Over time some of these trades gets closed off, while the
rest of them remain open. The sum of the profits in pips of the closed trades plus the sum of the profit or loss
in pips of the open trades gives the run's profit & loss in pips. When the run's profit & loss in pips reaches this
Target Profit Pips then the EA closes off all open trades and completes the run.

Example: I want the EA to close off all open trades when the aggregated profits of all currently open and so far
closed trades reaches 100 pips.

Here is an EA configuration to achieve the above:

 1. Target Profit Pips = 100
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4.2.2 Indicator And Trading Logic Settings

 BUY Leg Settings
 Buy: RSI Indicator Period

Buy: RSI Indicator Period

Used for, and corresponds to the RSI indicator's period parameter.
 Buy: RSI Entry Method

Buy: RSI Entry Method

Selects the way of new position entry.
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Buy: RSI Entry Method Description

Turned Off
Buy entry is turned off. No new buy position is
entered.

Upward Crossover: Below to Above

New buy entry is triggered when the price crosses
or touches the Buy: RSI Entry Level from below to
above.

The trigger is considered qualified when

• the RSI reading is below the Buy: RSI Entry
Level for the second last closed bar, and

• the RSI reading is on or above the Buy: RSI
Entry Level for the last closed bar

Downward Crossover: Above to Below

New buy entry is triggered when the price crosses
or touches the Buy: RSI Entry Level from above to
below.

The trigger is considered qualified when

• the RSI reading is above the Buy: RSI Entry
Level for the second last closed bar, and

• the RSI reading is on or below the Buy: RSI
Entry Level for the last closed bar

 Buy: RSI Entry Level

Buy: RSI Entry Level

The value of the RSI indicator which is to be crossed by the actual RSI readings to trigger a new position entry.
 Buy: RSI Exit Method

Buy: RSI Exit Method

Selects the way of closing off existing buy positions.

Buy: RSI Exit Method Description

Turned Off

No existing buy position gets closed off due to RSI
crossover. The various other Position Management
methods - involving SL and TP adjustments - will
be the way getting an open position closed.

Upward Crossover: Below to Above

Closing of an open buy position is triggered when
the price crosses or touches the Buy: RSI Exit Level
from below to above.

The trigger is considered qualified when

• the RSI reading is below the Buy: RSI Exit
Level for the second last closed bar, and

• the RSI reading is on or above the Buy: RSI
Exit Level for the last closed bar
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Buy: RSI Exit Method Description

Downward Crossover: Above to Below

Closing of an open buy position is triggered when
the price crosses or touches the Buy: RSI Exit Level
from above to below.

The trigger is considered qualified when

• the RSI reading is above the Buy: RSI Exit
Level for the second last closed bar, and

• the RSI reading is on or below the Buy: RSI
Exit Level for the last closed bar

 Buy: RSI Exit Level Mode

Buy: RSI Exit Level Mode

Selects the way the buy RSI Exit Level is determined. The buy RSI exit level value can be either entered by the
user or calculated automatically by the EA.

Buy: RSI Exit
Level Mode

Description

Manual Exit Level
The buy RSI exit value is configured by the user as entered into the input field
Buy: RSI Exit Level.

Auto-Balanced Exit
Level

The buy RSI exit value is calculated by the EA automatically. In this case the
Buy: RSI Exit Level is not used by the EA.

In order to get a balanced RSI entry and exit levels the EA takes the Buy: RSI
Entry Level value and comes up with the exit level at the opposite end of the
RSI range at the same distance. Here is a couple of examples of the calculated
balanced exit levels:

• Entry level of 20: balanced exit level of 80
• Entry level of 25: balanced exit level of 75
• Entry level of 30: balanced exit level of 70

 Buy: RSI Exit Level

Buy: RSI Exit Level

The value of the RSI indicator which is to be crossed by the actual RSI readings to trigger the closure of open buy
positions.

Note:  This input is only used by the EA if the mode Manual Exit Level is selected for the Buy: RSI Exit Level
Mode.

 Buy: Single or Multiple Entries

Buy: Single or Multiple Entries

Selects the way the RSI crossovers get traded:

Buy: Single or
Multiple Entries

Description

Single Entry After RSI
Cross

Only one new trade is entered when an RSI crossover takes place.
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Buy: Single or
Multiple Entries

Description

Multiple Entries After
RSI Cross

A new trade is entered for every new bar after an RSI crossover.

 Buy: Pruning At Max Trades

Buy: Pruning At Max Trades

Allows for replacement of an existing open trade by a new trade when the maximum open trades limit is reached.

Buy: Pruning
At Max Trades

Description

No Pruning

Pruning is turned off, no existing open trade gets closed off due to pruning. This
also means that no new trades are entered once the Max Total Trades Open at a
Time is reached.

Existing open trades are still managed and they may get closed off by hitting
their target or stop levels, or trailing stops etc.

Close Most Profitable
Trade

The open trade, either buy or sell, with the highest profit amount gets closed
during pruning. If all the open buy and sell trades are in losses then the one with
the least amount of losses gets closed out.

Close Least Profitable
Trade

The open trade, either buy or sell, with the least profit amount gets closed during
pruning. If all the open buy and sell trades are in losses then the one with the
most amount of losses gets closed out.

 SELL Leg Settings
 Sell Settings Source

Sell Settings Source

Offers an option to decouple the buy and sell side settings. By default, the sell side settings are coupled with the
buy side settings, i.e. the sell side settings are derived from the buy side to mirror the entry and exit settings. This
keeps the trading logic unbiased making buy and sell entries.

If different buy and sell side settings are desired then decouple the two sides by selecting the Custom: Manual
Sell Settings option and filling in all the EA input Sell: RSI ... parameters.
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Sell Settings Source Description

Automated: Based on By Settings

The sell side settings are derived from the buy side
settings to do the opposite of the buy side.

• Entry and Exit Methods:

• Buy Upward Crossover is mapped to
Sell Downward Crossover

• Buy Downward Crossover is mapped to
Sell Upward Crossover

• Entry Level: Sell Entry Level is calculated as
100 - Buy Entry Level

• Exit Level: Sell Exit Level is calculated as
100 - Buy Exit Level

Custom: Manual Sell Settings

The sell side uses the custom settings as provided by
the EA parameters Sell: RSI Ind. Period, Sell: RSI
Entry Method, Sell: RSI Entry Level, Sell: RSI Exit
Method and Sell: RSI Exit Level.

 Custom Sell Setup
 Sell: RSI Indicator Period

Sell: RSI Indicator Period

Used for, and corresponds to the RSI indicator's period parameter.
 Sell: RSI Entry Method

Sell: RSI Entry Method

Selects the way of new position entry.

Sell: RSI Entry Method Description

Turned Off
Sell entry is turned off. No new sell position is
entered.

Upward Crossover: Below to Above

New sell entry is triggered when the price crosses
or touches the Sell: RSI Entry Level from below to
above.

The trigger is considered qualified when

• the RSI reading is below the Sell: RSI Entry
Level for the second last closed bar, and

• the RSI reading is on or above the Sell: RSI
Entry Level for the last closed bar

Downward Crossover: Above to Below

New sell entry is triggered when the price crosses
or touches the Sell: RSI Entry Level from above to
below.

The trigger is considered qualified when

• the RSI reading is above the Sell: RSI Entry
Level for the second last closed bar, and

• the RSI reading is on or below the Sell: RSI
Entry Level for the last closed bar

 Sell: RSI Entry Level
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Sell: RSI Entry Level

The value of the RSI indicator which is to be crossed by the actual RSI readings to trigger a new position entry.
 Sell: RSI Exit Method

Sell: RSI Exit Method

Selects the way of closing off existing sell positions.

Sell: RSI Exit Method Description

Turned Off

No existing sell position gets closed off due to RSI
crossover. The various other Position Management
methods - involving SL and TP adjustments - will
be the way getting an open position closed.

Upward Crossover: Below to Above

Closing of an open sell position is triggered when
the price crosses or touches the Sell: RSI Exit Level
from below to above.

The trigger is considered qualified when

• the RSI reading is below the Sell: RSI Exit
Level for the second last closed bar, and

• the RSI reading is on or above the Sell: RSI
Exit Level for the last closed bar

Downward Crossover: Above to Below

Closing of an open sell position is triggered when
the price crosses or touches the Buy: RSI Exit Level
from above to below.

The trigger is considered qualified when

• the RSI reading is above the Sell: RSI Exit
Level for the second last closed bar, and

• the RSI reading is on or below the Sell: RSI
Exit Level for the last closed bar

 Sell: RSI Exit Level Mode

Sell: RSI Exit Level Mode

Selects the way the sell RSI Exit Level is determined. The sell RSI exit level value can be either entered by the
user or calculated automatically by the EA.

Sell: RSI Exit Level Mode Description

Manual Exit Level
The sell RSI exit value is configured by the user as entered into the input field
Sell: RSI Exit Level.
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Sell: RSI Exit Level Mode Description

Auto-Balanced Exit
Level

The sell RSI exit value is calculated by the EA automatically. In this case the
Sell: RSI Exit Level is not used by the EA.

In order to get a balanced RSI entry and exit levels the EA takes the Sell: RSI
Entry Level value and comes up with the exit level at the opposite end of the
RSI range at the same distance. Here is a couple of examples of the calculated
balanced exit levels:

• Entry level of 20: balanced exit level of 80
• Entry level of 25: balanced exit level of 75
• Entry level of 30: balanced exit level of 70

 Sell: RSI Exit Level

Sell: RSI Exit Level

The value of the RSI indicator which is to be crossed by the actual RSI readings to trigger the closure of open sell
positions.

Note:  This input is only used by the EA if the mode Manual Exit Level is selected for the Sell: RSI Exit Level
Mode.

 Sell: Single or Multiple Entries

Sell: Single or Multiple Entries

Selects the way the identified trend gets traded:

Sell: Single or
Multiple Entries

Description

Single Entry After RSI
Cross

Only one new trade is entered when an RSI crossover takes place.

Multiple Entries After
RSI Cross

A new trade is entered for every new bar after an RSI crossover.

 Sell: Pruning At Max Trades

Sell: Pruning At Max Trades

Allows for replacement of an existing open trade by a new trade when the maximum open trades limit is reached.

Buy: Pruning
At Max Trades

Description

No Pruning

Pruning is turned off, no existing open trade gets closed off due to pruning. This
also means that no new trades are entered once the Max Total Trades Open at a
Time is reached.

Existing open trades are still managed and they may get closed off by hitting
their target or stop levels, or trailing stops etc.

Close Most Profitable
Trade

The open trade, either buy or sell, with the highest profit amount gets closed
during pruning. If all the open buy and sell trades are in losses then the one with
the least amount of losses gets closed out.
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Buy: Pruning
At Max Trades

Description

Close Least Profitable
Trade

The open trade, either buy or sell, with the least profit amount gets closed during
pruning. If all the open buy and sell trades are in losses then the one with the
most amount of losses gets closed out.

 Market Phase Settings
 Market Phase Filter

Market Phase Filter

Allows for the identification of trending vs sideways market phases and applying the selected trading strategy.

Market Phase Filter Description

Disable Market Phase
Filter

Turns off the market phase filter feature. New trade entries will only be based on
the RSI crossovers.

Enable Market Phase
Filter

Turns on the market phase filter feature. New trade entries will be based on the
selected Market Phase Strategy along with the RSI crossovers.

 Market Phase Strategy

Market Phase Strategy

Market Phase Strategy Description

Continuation Strategy
A new trade is only entered if the ADX reading is on or above the ADX Trigger
Level, otherwise the entry gets filtered and does not take place.

Reversal Strategy
A new trade is only entered if the ADX reading is on or below the ADX Trigger
Level, otherwise the entry gets filtered and does not take place.

See the various examples of the Market Phase Settings in the following table:

Example Use Case Description

Trading only the RSI crosses
regardless of market the phase

Example: I always want to trade the market when an RSI crossover
takes place. I want only one trade right after an RSI crossover, but no
further trade until after the next RSI cross.

Here is an EA configuration to achieve the above:

 1. Buy: Single or Multiple Entries = Single Entry After RSI Cross
 2. Market Phase Filter = Disable Market Phase Filter

Note:  Due to the nature of the RSI indicator there could be multiple
crosses of the same level in a row. In this case there will be one new
entry after each of these crosses.
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Example Use Case Description

Trending market phase:
Continuation Strategy using the
RSI crosses

Example: I want to trade the market in a trend following manner. I
want new trades only when the 14 period ADX reading is on or above
25, and I want to enter a new trade upon every new bar after the RSI
cross.

Here is an EA configuration to achieve the above:

 1. Buy: Single or Multiple Entries = Multiple Entries After RSI
Cross

 2. Market Phase Filter = Enable Market Phase Filter
 3. Market Phase Strategy = Continuation Strategy
 4. ADX Period = 14
 5. ADX Trigger Level = 25

Bouncing or sideways market
phase: Reversal Strategy using
the RSI crosses

Example: I want to trade the market in a bounce back (counter-trend)
manner. I want new trades only when the 14 period ADX reading is on
or below 25, and I want to enter a new trade upon every new bar after
the RSI cross.

Here is an EA configuration to achieve the above:

 1. Buy: Single or Multiple Entries = Multiple Entries After RSI
Cross

 2. Market Phase Filter = Enable Market Phase Filter
 3. Market Phase Strategy = Reversal Strategy
 4. ADX Period = 14
 5. ADX Trigger Level = 25

 ADX Period

ADX Period

Used for and corresponds to the ADX indicator's period parameter.
 ADX Trigger Level

ADX Trigger Level

Corresponds to the ADX indicator main reading. The EA uses the ADX reading in order to apply the selected
Market Phase Strategy.

Note:  The EA does not use the -DI or the +DI values, only the main ADX value.
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4.2.3 Common Settings

 Trade Limits
 Trade After Loss

Trade After Loss

Offers an option to limit subsequent buy or sell trades in a trending market. In trending market there could be
subsequent trades with the same direction entered and closing with losses. In order to avoid these losses in a
trending market the EA may trade only in the opposite trade direction should the last trade closed off with losses.

Trade After Loss Description

Only Opposite Trade

New buy entry is performed only if

• The last closed trade was a sell trade, or
• The last closed trade was a buy with profit.

New sell entry is performed only if

• The last closed trade was a buy trade, or
• The last closed trade was a sell with profit.

Unlimited Same Trade Reentry
New buy or sell entry is performed regardless of the
direction or profitability of the last closed trade.

 Max Spread for Position Entry

Max Spread for Position Entry

The maximum value of the current market spread the EA is allowed to perform market entry, i.e. to open a new
position. If the current spread of the market exceeds this limit then the EA will not consider to open position until
after the spread drops to or below this value.

 Max Total Trades Open at a Time

Max Total Trades Open at a Time

The limit to the number of open buy and sell trades together entered and maintained by the EA at any point in
time. How this limit is applied to the trading logic is determined by the Buy: Pruning At Max Trades and the Sell:
Pruning At Max Trades.
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4.2.4 Position Management

 Direction of Trade Entry

Direction of Trade Entry

Option to reverse or not a trigger when a new position gets entered.

Direction of Trade Entry Description

Same as Trigger Direction (Buy
Trigger => Buy Trade)

The new trade is entered as:

• When the Buy: RSI Entry Method/Entry Level identifies a BUY
opportunity -> opens a BUY position.

• When the Sell: RSI Entry Method/Entry Level identifies a SELL
opportunity -> opens a SELL position.
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Direction of Trade Entry Description

Reverse Trigger Direction (Buy
Trigger => Sell Trade)

The new trade is entered as:

• When the Buy: RSI Entry Method/Entry Level identifies a BUY
opportunity -> opens a SELL position.

• When the Sell: RSI Entry Method/Entry Level identifies a SELL
opportunity -> opens a BUY position.

 Initial SL for New Position

Initial SL for New Position, Pips

The Stop Loss value in pips for a new position, set after market entry. When configured as zero then no Stop Loss
is set for new positions.

Example: I want to have Stop Loss of 60 pips after entering a new trade. I want to take profit of 100 pips gain off
the trade.

Here is an EA configuration to achieve the above:

 1. Take Profit = 100
 2. Initial SL for New Position = 60

 Take Profit

Take Profit, Pips

Target profit value in pips for a new position, set after market entry. When configured as zero then no Take Profit
is set for new positions.

Example: I want to take profit at 100 pips gain after entering a new trade. The Stop Loss for the trade is 60 pips.

Here is an EA configuration to achieve the above:

 1. Take Profit = 100
 2. Initial SL for New Position = 60

 Position Sizing
 Position Sizing Method

Position Sizing Method

The position sizing mechanism used for new trades at market entry.

Position Sizing Method Description

Percent of Account Free Margin

The lots for new position is calculated based on

• Free Margin available on account, and
• Initial Risk Percent, and
• Initial SL for New Position

The lots for the new position is calculated in a way that should the
initial SL get hit the loss would not be higher than the risk percent of
the free margin.
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Position Sizing Method Description

Percent of Account Equity

The lots for new position is calculated based on

• Equity available on account, and
• Initial Risk Percent, and
• Initial SL for New Position

The lots for the new position is calculated in a way that should the
initial SL get hit the loss would not be higher than the risk percent of
the equity.

Percent of Account Balance

The lots for new position is calculated based on

• Balance available on account, and
• Initial Risk Percent, and
• Initial SL for New Position

The lots for the new position is calculated in a way that should the
initial SL get hit the loss would not be higher than the risk percent of
the account balance.

Manual Lot Size
The lots for the new position is not calculated by the EA, instead it is
fixed and set to the user-defined value from Lots for Manual Lot Size.

The position sizing calculation takes place at the time of market entry, when all the entry criteria are met.

The calculated lots value is normalized according to the minimum lots size and lots stepping requirements of
the MT4 terminal. Therefore the actual risk amount may vary and will be a best effort and approximate of the
configured target risk value.

When the calculated lots value is higher than the broker maximum allowed lot size, the EA truncates the lots to
the maximum allowed figure and carries on with this capped lots value.

Furthermore, the market conditions (e.g. fast price movements) or the MT4 operational conditions (e.g. lost
connectivity to broker) may alter the actual exit point of an open trade, resulting in higher or lower actual risk
compared to the configured target risk value.

 Initial Risk Percent

Initial Risk Percent

Determines the risk amount allocated to a new trade as a percent of the broker account value. For more details see
the Position Sizing Method

 Lots for 'Manual Lot Size'

Lots for 'Manual Lot Size'

Sets the fixed lot size for new positions to this user-defined value when the Manual Lot Size option is selected for
Position Sizing Method.

 Breakeven
 Move to SL to Breakeven at Profit

Move SL to Breakeven at Profit, Pips

The EA moves an existing open position's stop loss to break even (i.e. its entry price) when the position gets into
profit by at least this Move SL to Breakeven at Profit pips.

This breakeven feature can be turned off by setting the Move SL to Breakeven at Profit to zero value.
 Lock-in Profit At Breakeven Move

Lock-in Profit At Breakeven, Pips

This EA parameter works together with the Move SL to Breakeven at Profit. When an existing open position
gets into profit by at least Move SL to Breakeven at Profit pips, then the position's stop loss gets moved to break
even point, and potentially further offset it into profit by the number of pips specified by this Lock-in Profit At
Breakeven parameter.
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Assuming the following configuration:

• Move SL to Breakeven at Profit = 10
• Lock-in Profit At Breakeven = 2
• An existing buy position with open price of 1.1200 gets into profit by 11 pips.

Because the open position reached the minimum profit level of 10, the EA moves the stop loss to 1.1202 which is
break even plus 2 pips of profit lock-in.

Note:  If the Lock-in Profit At Breakeven was set to zero then the stop loss would bed to break even of 1.1200.

 Trailing Stop
 Trailing Start at Profit

Trailing Start at Profit, Pips

The EA starts off the trailing of price by moving an existing open position's stop loss when the position gets into
profit by at least this Trailing Start at Profit pips. Once the trailing got activated, the SL gets adjusted every time
when the price moves further and the position gets further into profit by Trailing Stepping pips. Refer to Trailing
SL and Trailing Stepping for more details.

 Trailing SL

Trailing SL, Pips

When trailing feature is activated, the SL of the position is set by this amount of pips behind the last peak of price
in profit.

 Trailing Stepping

Trailing Stepping, Pips

When trailing feature is actived and the price moves in the favour of the position by this amount of pips again
then the position's SL gets adjusted again. The new SL is set to be Trailing SL behind of the most recent peak
price in profit.

For instance, assuming the following trailing settings:

 1. Trailing Start at Profit = 10
 2. Trailing SL = 20
 3. Trailing Stepping = 5

When the open position reaches first time into profit by 10 pips the EA sets the position's SL to current price - 20
pips, which is actually 10 pips in loss compared to the original entry.

When the price advances further into profit by 5 pips then the EA pulls the SL by 5 pips, re-setting the SL to
current price - 20 pips. In other words, the SL trails the best price by steppings of 5 pips, keeping the stop loss
distance to 20 pips at each adjustment.

 Dynamic Stop
 Dynamic Stop Start at Profit

Dynamic Stop Start at Profit, Pips

The EA brings progressively forward the Stop Loss of an existing position when the price moves closer to the
Take Profit of the position. Over time, the smaller the gap to the Take Profit becomes the smaller the stop behind
the current price gets used.

Tip:  Watch the Expert4x Dynamic Stop video about this concept.

The EA starts to bring forward the SL of a position when the position gets into profit by at least this Dynamic
Stop Start at Profit pips. Once the dynamic stop got activated the SL gets furhter brought forward every time
when the price moves on and the position gets further into profit by Dynamic Stop Stepping pips. The SL gets
recalculated to be the same distance on the stop side as the number of pips are left to reach the Take Profit level.
That is the stop gets narrower as the price gets closer to the target.

For instance, assuming the following settings:

 1. Take Profit = 100 pips
 2. Dynamic Stop Start at Profit = 50 pips
 3. Dynamic Stop Stepping = 10 pips

https://www.youtube.com/watch?v=vJssuFpjskE
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When the open position the first time goes into profit by 50 pips the EA identifies that another 50 pips is left to
reach the TP level. The SL gets recalculated to be that 50 pips behind the current price, i.e. break even in this
example.

When the price advances further into profit by 10 pips then the EA identifies that another 40 pips is left to reach
the TP. The SL gets recalculated to be that 40 pips behind the current price, i.e. 10 pips in profit from the original
entry price. Every time the price advances further and making the position into profit by another 10 pips, the EA
will move the SL tighter and reduce the size of the SL by that 10 pips.

Related information
Expert4x Dynamic Stop video

 Dynamic Stop Stepping

Dynamic Stop Stepping, Pips

The EA brings progressively forward the Stop Loss of an existing position when the price moves closer to the
Take Profit of the position. Over time, the smaller the gap to the Take Profit becomes the smaller the stop behind
the current price gets used.

Tip:  Watch the Expert4x Dynamic Stop video about this concept.

The EA starts to bring forward the SL of a position when the position gets into profit by at least this Dynamic
Stop Start at Profit pips. Once the dynamic stop got activated the SL gets furhter brought forward every time
when the price moves on and the position gets further into profit by Dynamic Stop Stepping pips. The SL gets
recalculated to be the same distance on the stop side as the number of pips are left to reach the Take Profit level.
That is the stop gets narrower as the price gets closer to the target.

For more details and example refer to Dynamic Stop Start at Profit for more details.

Related information
Expert4x Dynamic Stop video

 Dynamic Target
 Dynamic Target Start at Loss

Dynamic Target Start at Loss, Pips

The EA pulls back the Take Profit of an existing position when the price moves closer to the Stop Loss of the
position.

Tip:  Watch the Expert4x Dynamic Target video about this concept.

The EA starts off pulling back the TP of a position when the position gets into losses by at least this Dynamic
Target Start at Loss pips. Once the dynamic target got activated the TP gets furhter pulled back every time when
the price moves on and the position gets further into losses by Dynamic Target Stepping pips.

For instance, assuming the following settings:

 1. Take Profit = 100 pips
 2. Dynamic Target Start at Loss = 50 pips
 3. Dynamic Target Stepping = 10 pips

When the open position the first time goes into loss by 50 pips the EA pulls back the position's TP by 50 pips.
The new TP will be the current price - 100 pips, that is +50 pips from the original entry.

When the price advances further into losses by 10 pips then the EA pulls further back the TP by 10 pips, re-
setting the TP to current price - 100 pips, that is +40 pips from the original entry. In other words, the TP trails the
latest price leading to losses by steppings of 10 pips, keeping the TP distance to 100 pips at each adjustment.

Related information
Expert4x Dynamic Target video

 Dynamic Target Stepping

Dynamic Target Stepping, Pips

The EA pulls back the Take Profit of an existing position when the price moves closer to the Stop Loss of the
position.

https://www.youtube.com/watch?v=vJssuFpjskE
https://www.youtube.com/watch?v=vJssuFpjskE
https://www.youtube.com/watch?v=vJssuFpjskE
https://www.youtube.com/watch?v=DmKyTJEAv3U
https://www.youtube.com/watch?v=DmKyTJEAv3U
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Tip:  Watch the Expert4x Dynamic Target video about this concept.

Once the dynamic target got activated the TP gets furhter pulled back every time when the price moves on and
the position gets further into losses by this Dynamic Target Stepping pips.

For more details and example refer to Dynamic Target Start at Loss for more details.

Related information
Expert4x Dynamic Target video

4.2.5 Day of Week & Time of Day Entry Filter

 Reference Time Selection

Reference Time Selection

Selects the nature of the time used by the EA when time specific actions are performed.

Reference
Time Selection

Description

Broker Server Time
Entry window hour and minute settings are relevant to the broker's server time.
See below picture showing the broker server time in the Market Watch window.

PC Local Time
Entry window hour and minute settings are relevant to the local time of the PC
hosting the MT4 terminal and EA. When setting up the time parameters consider
the time zone differences between the market open hours versus the PC local time.

https://www.youtube.com/watch?v=DmKyTJEAv3U
https://www.youtube.com/watch?v=DmKyTJEAv3U


theTradeableRSI EA Configuration Guide

Page 32

Reference
Time Selection

Description

GMT Time (Set GMT
Offset Below)

Entry window hour and minute settings are relevant to the selected GMT offset.

This feature is useful to keep the entry window hour and minute settings the
same when the EA is executed across different brokers. In this case only the
broker GMT offset needs to be set on the different brokers' MT4 instances, and
the EA adjusts automatically the entry window for the broker.

In this case, use the GMT Offset of Broker to select the broker offset and always
set the window hour values in GMT +0 time zone.

 GMT Offset of Broker

GMT Offset of Broker

The time zone shift of the MT4 broker's server time. This parameter is only required if GMT Time option is
selected for the Reference Time Selection.

Unfortunately MT4 terminal does not provide this broker GMT offset information therefore a query to the broker
maybe needed to get this value. As an alternative, one may make an attempt to calculate this offset through the
following steps:

 1. The Market Watch window's header shows the broker's server time, press Ctrl+M in the MT4 terminal:

This time can be compared to the GMT+0 time to calculate the GMT offset of the broker.
 2. In a web browser search for gmt time keywords to see the current GMT time.
 3. Then compare the search result of current GMT time to the current time displayed by the Market Watch

window of the MT4 terminal. The difference of the two times gives the broker GMT offset.
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Based on past experience, with no guarantee that the information is correct, these are a few sample broker GMT
offsets observed as of July 2015:

MT4 Terminal Broker GMT Offset

AxiTrader AxiCorp Financial Services Pty Ltd +3

IC Markets International Capital Markets Pty Ltd +3

InstaForex InstaForex Companies Group +3

FXCM Forex Capital Markets Inc +3

ThinkForex TF Global Markets (Aust) Pty Ltd +3

RoboForex EU RoboForex (CY) Ltd +3

Tallinex Tallinex Ltd 0

Oanda OANDA Corporation -4

MB Trading FX MB Trading Futures Inc -4

The value in the GMT Offset column could be used for the EA parameter GMT Offset of Broker.

 Entry Window From Hour/Minute - Entry Window Until Hour/Minute

Entry Window From Hour/Minute - Entry Window Until Hour/Minute

Limits the period of a day when a new position entry may take place.

The From Hour & Minute is inclusive, while the Until Hour & Minute is exclusive. The following table shows
examples how to configure these parameters for the entry window period:

Desired Entry Period Entry Window From Entry Window Until

8 – 10 (i.e. 8:00.00–9:59.59) Hour = 8 & Minute = 0 Hour = 10 & Minute = 0

10 – 17 (i.e. 10:00.00-16:59.59) Hour = 10 & Minute = 0 Hour = 17 & Minute = 0

All Day Hour = 0 & Minute = 0 Hour = 24 & Minute = 0

The entry window from and until hours are specific to the selected time at Reference Time Selection.

 Monday ... Sunday Trade Entry

Monday ... Sunday Trade Entry

Days allowed for new position entry. Subsequent management of stop loss or exit of already open trades may
happen outside of the enabled days, only the entry of new positions is limited to the selected days:



theTradeableRSI EA Configuration Guide

Page 34

Day of Week Trade Entry Description

No Entry

No new entry is executed on that day.

Stop Loss management, if turned on, for existing open positions are still
executed as normal.

Entry Enabled New entry is allowed for the day when all other entry criteria are met.

4.2.6 Operations Settings

 Closeout Summary Text Colour

Closeout Summary Text Colour

The colour of the text in the chart describing the summary of the run closure. The run gets closed off when one of
the exit conditions configured at the section Combined Target Settings gets fulfilled.

 Tick Scaling for CFD Markets
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Tick Scaling for CFD Markets

Provides a consistent tick, pip, cent and point values across various markets and brokers. This is specific to stock
indices, metal, commodity etc markets keeping the cent or dollar unit consistently applied. Wherever the EA
is configured with a 'Pip' value then it is consistently mapped to the cent or dollar unit for those non-FOREX
markets.

Tick Scaling for
CFD Markets

Description

Auto Scale for Index
Markets

Based on the characteristics of the market the EA automatically recognizes if the
underlying market was a stock index market, like the US30, GER30 or JP225
etc. In this case the 'pip' values configured for the EA are scaled up to the 'dollar'
value of the index: 12345.67

Never Scale
The EA does not scale up the 'pip' values even if the market could be recognized
as a stock index market.

Always Scale
The EA applies the scaling up of the 'pip' values to the 'dollar' value even if the
market could not be recognized as stock index market. This option is useful if
the 'dollar' based approach is desired for trading.

Note:  The EA always deals with the fractional pip values therefore there is no need to increase the 'pip' values
for brokers with 1, 3 or 5-digit data feed.

Examples:

Trading
Approach

Chart of
Market

Stop
Loss EA

Parameter
Value

Tick Scaling
for CFD
Markets
Value

Buy Entry
Fill Price

Calculated
Stop Loss

Value
Description

Index
market with
$1.00 unit

US30 100

Auto Scale
for Index
Markets

Alternative:
Always
Scale

26123.90 26023.90

The EA
scales the
100 'pips'
parameter
to market
price of
100.00 US
dollar units
(i.e. 100.00
points)

FOREX
pair with
0.0001 unit

EURUSD 100

Auto Scale
for Index
Markets

Alternative:
Never
Scale

1.13412 1.12412

The EA
keeps the
100 'pips'
parameter
as it is

Gold
market with
$0.01 unit

XAUUSD 100

Auto Scale
for Index
Markets

Alternative:
Never
Scale

1288.23 1287.23

The EA
maps the
100 'pips'
parameter
to 100 cent
units



Trading
Approach

Chart of
Market

Stop
Loss EA

Parameter
Value

Tick Scaling
for CFD
Markets
Value

Buy Entry
Fill Price

Calculated
Stop Loss

Value
Description

Gold
market with
$1.00 unit

XAUUSD 100
Always
Scale

1288.23 1188.23

The EA
maps the
100 'pips'
parameter
to 100
dollar units

Oil market
with $0.01
unit

USOil 100

Auto Scale
for Index
Markets

Alternative:
Never
Scale

56.752 55.752

The EA
maps the
100 'pips'
parameter
to 100 cent
units

Oil market
with $1.00
unit

USOil 10
Always
Scale

56.752 46.752

The EA
maps the
10 'pips'
parameter
to 10 dollar
units

Copper
market with
$0.01 unit

COPPER 100

Auto Scale
for Index
Markets

Alternative:
Never
Scale

2.9245 1.9245

The EA
maps the
100 'pips'
parameter
to 100 cent
units

Cocoa
market with
$0.01 unit

COCOA 100

Auto Scale
for Index
Markets

Alternative:
Never
Scale

2160 2060

The EA
maps the
100 'pips'
parameter
to 100 cent
units

Natural gas
market with
$0.01 unit

NGAS 100

Auto Scale
for Index
Markets

Alternative:
Never
Scale

2.843 1.843

The EA
maps the
100 'pips'
parameter
to 100 cent
units

 Magic Number Parameter

Magic Number

The EA marks its orders with this value when submitting to the broker account, and picks up orders which are
marked with this magic number value and belong to the chart of the EA. In the case of multiple EA's running on
the same market ensure that they get unique Magic Number allocations to avoid cross-impact between the EA
instances handling the orders. See Configuration and Operation Principles section for more explanation and setup
examples.

Related information
Configuration and Operation Principles
The theTradeableRSI EA operational overview.



Page 37

Chapter

5
 Knowledgebase

Frequently Asked Questions and other common use cases.

5.1 How to Download MT4

Question

How can I install the MT4 platform?

I checked the MetaQuotes site and it looks like I can only download the MT5 platform.

Answer

The way to get and install MT4 is to download it directly from your broker.

Please download the MT4 setup application directly from one of your preferred brokers web site.

5.2 How to Download the Setup Application

Question

How to download the theTradeableRSI EA Setup application?

1. Log in to the Web Support Centre.

2. Scroll down and click on the theTradeableRSI EA in the Product List.

https://my.eafactory.com/Expert4x
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3. Click on the Product Download button to download the EA setup.

5.3 How to Install the theTradeableRSI EA
The theTradeableRSI EA comes with a setup application to provide a wizard based installation process to the
selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT4 terminal version 4.00 build 1280 or later installed.

1. Exit MT4 if it was running.

2. Select the desired service and download the setup application with the latest version.

3. Run the setup application. Select the MT4 instance during setup to where you want the service installed.

4. When setup completes start up MT4. The theTradeableRSI EA entry should appear under the Expert
Advisors node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.
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The setup application lists the available MT4 instances. Select one of them for installation target and click on the
Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances. In this case use the
Add target directory... button to navigate and pick up the desired folder.

C:\Program Files\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader installation. As a hint, the following
shows you the default path to the main MT4 directory for some brokers:

Broker Default Path

Blueberry Markets broker C:\Program Files (x86)\Blueberry Markets MetaTrader 4 Terminal

Dukascopy broker C:\Program Files (x86)\Dukascopy MetaTrader 4

IG broker C:\Program Files (x86)\IG MetaTrader 4 Terminal

OANDA broker C:\Program Files (x86)\OANDA - MetaTrader

Pepperstone broker C:\Program Files (x86)\Pepperstone MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its sub-directories.
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When the installation is complete, start up MT4 and check that the EA appears in the Navigator window (View >
Navigator):

So everything is set up for the first activation of the theTradeableRSI Expert Advisor  .

5.4 How to Upgrade the EA

Question

How to upgrade the theTradeableRSI EA?

Answer

In order to upgrade the EA please follow these steps:

 1. Download the latest theTradeableRSI EA from the Web Support Centre. For detailed steps refer to the How
to Download the Setup Application.

https://my.eafactory.com/Expert4x
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 2. Exit the MT4 terminal if it was running.
 3. Execute the downloaded theTradeableRSI EA setup application. Follow through all of the wizard pages to

complete the EA installation.
 4. Start up the MT4 terminal.

The upgraded theTradeableRSI EA will pick up and carry on managing any existing trades created by the
previous EA version.

Related tasks
Step-by-step Installation of Expert4x EAs and Indicators

How to download an EA setup in VPS environment

Related information
How to Download the Setup Application

5.5 How to Attach the theTradeableRSI Expert Advisor  to a Chart
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the theTradeableRSI Expert Advisor  in a few
steps.

Attach the EA to a chart

1. Drag & drop the theTradeableRSI Expert Advisor  from the Navigator window (View > Navigator) to a
chart window and select the Common tab:

Note:

Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are ticked.

2. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the theTradeableRSI EA can be set up.
For more details see the theTradeableRSI EA Configuration Guide – for now click on the OK button and
let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

The theTradeableRSI EA is up and running

After successful authentication the theTradeableRSI EA starts up.

https://my.eafactory.com/expert4x
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The theTradeableRSI Expert Advisor  has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the theTradeableRSI Expert Advisor  was successful and the EA is now looking
for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

5.6 How to Load Setfile from the Settings Analysis Site
In this topic we guide you through how to download the EA settings from the Settings Analysis page, and load
those settings into the EA in the MT4 application.

1. First, download the set file: Go to the Settings Analysis page.

2. Click on the analysis type, FOREX or INDEX markets, for which you want to get the set file. For instance,
click on the Comprehensive analysis: Details link on the Settings Analysis page.

3. Right-click on the  sign and select Save link as...

https://settings.eafactory.com/
https://settings.eafactory.com/
https://settings.eafactory.com/
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4. Click on Downloads in the Quick access list then click on the Save button:

5. Now load the set file into your EA on an MT4 chart: Attach the EA to a new or existing chart.

6. Click on the Load button:

7. Click on the Downloads in the Quick access list then double-click on the set file:
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8. This loads the settings from the set file into the EA parameters. Click on the OK button:

5.7 MetaViewer dll could not be found

Issue

After the EA setup application finished the following error message was popped up:

There was a problem starting C:\Windows\system32\MetaViewer.dll The specified module could not be
found.

There was a problem starting C:\Windows\system32\MetaViewer64.dll The specified module could not be
found.

Solution

From the EA installation perspective you can ignore this message.

The installer was at the very last step to start up the Users Manual PDF viewer. This is a request to the Windows
operating system to start the registered PDF reader application and looks like Windows could not start up the
PDF reader for some reason. This is probably a Windows or an MT4 settings problem.
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Please double check that the EA appears in the MT4 terminal Navigator window (press Ctrl+N), it should be
listed at the section Expert Advisors.

5.8 theTradeableRSI Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the theTradeableRSI Expert Advisor  in a few
steps.

Attach the EA to a chart

1. Drag & drop the theTradeableRSI Expert Advisor  from the Navigator window (View > Navigator) to a
chart window and select the Common tab:

Note:

Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are ticked.

2. Select the Inputs tab:
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This lists the parameters of the EA where the operational aspect of the theTradeableRSI EA can be set up.
For more details see the theTradeableRSI EA Configuration Guide – for now click on the OK button and
let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support site. Feel free to
change your Access ID at the Web Support Centre and ensure not to share it with anyone else. Enter the
Access ID and click on the Save button:

The theTradeableRSI EA is up and running

After successful authentication the theTradeableRSI EA starts up.

https://my.eafactory.com/expert4x
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The theTradeableRSI Expert Advisor  has been attached to the chart. The smiley face in the top-right corner
shows that the initialisation of the theTradeableRSI Expert Advisor  was successful and the EA is now looking
for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

5.9 Sad Face Instead of Smiley Face After Attach

Issue

After attaching to chart the EA is not managing trades, a sad face appears in the top right corner of the chart.
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EA's common parameters might be not enabled

The Allow live trading, Allow DLL imports and Allow import of external experts might be not enabled

• Press F7 key and verify that the Allow live trading, Allow DLL imports and Allow import of external
experts are checked in the EA property dialog.

Autotrading is disabled

The AutoTrading might be disabled

• Verify that the toolbar button AutoTrading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:

5.10 What is the Leverage of My Account

Question

What is the leverage of my MT4 broker account?

I am logged in to my demo or live MT4 account and want to know the leverage available on the account.
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Answer

The theTradeableRSI EA displays the MT4 account leverage on its dashboard, at the section Account Level Info.

See the reported leverage value at the end of the first line:

In the above picture the leverage is reported as 400, which represents 400:1 account leverage.

5.11 How to Figure Out My Broker's GMT Offset?
The MT4 platform presents its chart using the time of its broker server. The various brokers configure their server
time according to their own choice, many of them are in one of the European timezone ranging from GMT+0
to GMT+3, but some brokers opt to have their server in the US Estern timezone, which is GMT-5. These GMT
offsets may get further adjusted for the daylight savings from March till October of every year.

The theTradeableRSI EA uses the time for trading decisions therefore its time input parameters need to be
adjusted by the GMT offset of the broker's server. This article describes how to figure out the GMT offset
specific to the MT4 broker account.

1. The Market Watch window's header shows the broker's server time, press Ctrl+M in the MT4 terminal:

This time can be compared to the GMT+0 time to calculate the GMT offset of the broker, as per the next
step.

2. In a web browser search for gmt time keywords to see the current GMT time.

3. Calculate now the broker GMT offset = 'Market Wacth time' - 'GMT time'.

For an example, assuming the following:

• Market Watch time: 18:29
• GMT time as per the search result: 15:29

Then the calculated GMT offset is 18:29 - 15:29 = 3:00 hours. In practice - in the limited context of the forex
broker servers - it is sufficient to calculate the difference between the hour parts: 18 - 15 = 3 hours.

Note:  For broker servers located in Europe the GMT offset is likely to be in the range of 0 and 3, i.e. a zero or
positive number. For broker servers located in the US the GMT offset might be in the range of -5 and -6, i.e. a
negative number. Keep in mind that these figures may get further adjusted by the daylight savings.

Based on past experience, with no guarantee that the information is correct, these are a few sample broker GMT
offsets observed as of July 2015:

MT4 Terminal Broker GMT Offset

AxiTrader AxiCorp Financial Services Pty Ltd +3

IC Markets International Capital Markets Pty Ltd +3

InstaForex InstaForex Companies Group +3

FXCM Forex Capital Markets Inc +3
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MT4 Terminal Broker GMT Offset

ThinkForex TF Global Markets (Aust) Pty Ltd +3

RoboForex EU RoboForex (CY) Ltd +3

Tallinex Tallinex Ltd 0

Oanda OANDA Corporation -4

MB Trading FX MB Trading Futures Inc -4

5.12 EA Is Not Starting Up After Attach to Chart

Issue

The EA reports successful initialisation and advises about disabled Expert Advisors.

Autotrading is disabled

The AutoTrading might be disabled

• Verify that the toolbar button AutoTrading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:

5.13 No Updates to Chart

Issue

The theTradeableRSI EA does not update information on the chart for several minutes.

Connection Lost

MetaTrader should be connected to the broker's server.

1. Check the bottom right corner of MetaTrader, this is when it has lost connection to the server:
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2. If connection is lost then login again or restart MT to force reconnection. Try again activating the
theTradeableRSI EA when connection is back.

Demo account is expired

MT4 will not be able to connect to the demo account if it's expired. In this case MT4 will keep asking for the
login details and fail all login attempt.

• When this happens open a new demo account (right click Accounts in Navigator window and select Open
an Account).

Market is closed

New tick information and updates to chart happens when markets are open.

• Double check that markets are meant to be open currently.

Disk is full

There should be at least 50MB free disk space available on the drive MetaTrader is installed on.

• If the free disk space is low then free up space.

5.14 Prompted for Access ID at Service Access Settings

Issue

After attaching to chart the theTradeableRSI EA asks for my Access ID in the Service Access Settings window.

Type in your Access ID

The theTradeableRSI EA checks that the usage of product is appropriately licensed. After product purchase a user
profile is created on our web support site and the product can be downloaded from that web site. The support site
allows to set up an Access ID which is required by the theTradeableRSI EA to validate the product licence. By
default this Access ID is configured to be the same as your selected login name to the web support site.

• When prompted, please enter your Access ID to the window and click Save:
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Please do not share out to others your Access ID. That is against the licence agreement terms and
conditions and also all 3rd party usages will count when checking the number of EA copies being used.
Sharing out your Access ID can result in licence check failure and the EA may stop functioning.

Keep your Access ID secure, change it away from the its default value at any time on the Web Support
Centre site.

5.15 How to Edit the EA Input Values

Question

How can I edit or change the settings of the theTradeableRSI EA once it is attached to a chart?

Answer

In order to edit the input parameters of an EA which is already attached to a chart follow these steps

1. Select/click the chart which hosts the theTradeableRSI EA in your MT4 application.

2. Press F7 on your keyboard, or alternatively click on the smiley (or sad) icon in the top-right corner of the
chart.

3. Edit the theTradeableRSI EA input values in the appearing EA properties window

4. Click OK when editing is complete

5.16 Not Enough Memory For Bar History Or Indicator

Issue

Some of the market bar history data or an indicator fails to load because the MT4 runs out of memory. An error
message similar to the below is reported:

Solution

The bar history data takes up too much memory when loaded into RAM and the charts. The MT4 application
needs to be configured to keep less number of bars on the charts.

1. In the MT4 application menu select Tools > Options then select the Charts tab.

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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2. Enter 512000 into the Max bars in history, and 65000 into the edit box Max bars in chart:

3. Attach the EA to the chart now. If the issue is still there then go back to the previous step and enter half of
the previous values. Keep repeating these two steps - halving the values every time - until the EA attaches
successfully.

5.17 No Trades Due to Trade Disabled

Issue

The theTradeableRSI EA got attached to a chart, the EA is up and running. It keeps submitting market orders to
the broker server. However, the broker's server does not execute these market orders, instead, the broker says the
trade on this broker account is disabled:

The broker server reports the MT4 error code 133, which means that the trade is disabled on the account. This
is not an EA issue, instead, this is an issue with the broker account. For some reason the broker account does not
allow you to trade that market.

Solution

 1. Restart the MT4 terminal to see if the restart and reconnect to the broker resolves this: In the MT4 menu
select File > Exit, wait 5 seconds then start the MT4 up again.

 2. Identify another symbol for the same market which is enabled for trading: In the MT4 menu select View >
Symbols and search for symbol with different/extra suffix in the name, like EURUSDecn. Add that symbol
to the Market Watch window then attach the EA to this new symbol.

 3. Logging into your MT4 broker account with the investor login credentials disables trading. Ensure that you
log in to your broker account with the full trader login credentials.

 4. Create another demo account with the broker.
 5. Contact your broker and ask their support team to enable trading on the symbol or account

 1. Your broker account may have reached some trade limits (e.g. overall maximum lots).
 2. Your broker may have put (temporarily) trading limitations on your account for some reason.
 3. Your broker may have to enable trading by EAs.
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5.18 How to Load Setfile from the Settings Analysis Site for Backtesting
In this topic we guide you through how to download the EA settings from the Settings Analysis page, and load
those settings into the EA in the Strategy Tester of the MT4 application for backtesting.

1. First, download the set file: Go to the Settings Analysis page.

2. Click on the analysis type, FOREX or INDEX markets, for which you want to get the set file. For instance,
click on the Comprehensive analysis: Details link on the Settings Analysis page.

3. Right-click on the  sign and select Save link as...

4. Click on Downloads in the Quick access list then click on the Save button:

5. Now load the set file into your EA in the MT4 Strategy Tester: Go to the MT4 Strategy Tester and click on
the Expert properties button:

6. Click on the Load button:

https://settings.eafactory.com/
https://settings.eafactory.com/
https://settings.eafactory.com/
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7. Click on the Downloads in the Quick access list then double-click on the set file:

8. This loads the settings from the set file into the EA parameters. Click on the OK button:

9. Run the backtest: Click on the Start button of the Strategy Tester:
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5.19 Backtest In Visual Mode Not Working

Issue

In the Strategy Tester using the visual mode DLL imports not allowed message appears on the chart. No result
after the Strategy Tester finished its run.

Global Allow DLL imports is not enabled

You may need to enable the DLL imports in the MT4 for terminal global parameters to run the theTradeableRSI
EA in the backtest environment.

1. Open the MT4 global Options by selecting Tools > Option (CTRL+O)

2. Select the Expert Advisors tab

3. Check the Allow DLL import

4. Restart the MT4: exit the MT4 application, wait 5 seconds then start it up again.

5.20 Backtest Not Working

Issue

After the backtest finished no result showing.
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Global Allow DLL imports is not enabled

You may need to enable the DLL imports in the MT4 for terminal global parameters to run the theTradeableRSI
EA in the backtest environment.

1. Open the MT4 global Options by selecting Tools > Option (CTRL+O)

2. Select the Expert Advisors tab

3. Check the Allow DLL import
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4. Restart the MT4: exit the MT4 application, wait 5 seconds then start it up again.

5.21 Connection Down Message

Issue

The theTradeableRSI EA got attached to a chart and the EA is up and running. The EA monitors the connection
between the MT4 terminal and the broker server. When the MT4 loses connection to the broker server then the
EA presents this Connection Down message in its dashboard - see the orange message as an example:

In the above screenshot the last connection issue happened at 14:19 broker server time (chart time).

This means that somewhere along the Internet connection path from your computer to the broker server, including
your home networks, the Internet and your brokers remote networks, there was some temporary issue resulting in
data transfer interruption.

During this time the theTradeableRSI EA cannot receive price feed from the broker, i.e. no ticks are coming in.
This also means that, due to the lack of price feed and ticks, the EA is not activated and cannot perform trading or
managing open trades. When the MT4 re-establishes the connection to the broker server and price feed comes in
again then the EA automatically resumes its trading operations.

Solution

In order to minimize the downtime, please ensure the following:

 1. Your computer is connected to your home networks over a wire, i.e. cabled to your modem or router. Note
that wireless connectivity is more prone to connection issues.

 2. Use a cable based Internet service provider, if feasible. Wireless based Internet service providers, like
mobile or cellular based Internet providers could have more connectivity issues.

 3. Turn off the sleep or hibernation mode on your computer. When your computer goes into sleep or
hibernation the Internet connection would be lost.

 4. If in doubt, restart your home networks: shutdown your computer, turn off your modem or router, wait 10
seconds then turn back on the modem/router then your computer.

Note that even the best Internet connection could see a handful of connection issues on a daily basis. When you
see more than a handful, like into 100 or more a day then your attention is needed.

5.22 Suspended Message

Issue

The theTradeableRSI EA got attached to a chart and the EA is up and running. After a while the dashboard shows
the suspended message:

The suspended message simply tells you that the actual market spread got higher than the configured Max Spread
for Position Entry for a period of time.
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Solution

Here is an example screenshot where the Max Spread for Position Entry is set to 5 pips:

The EA temporarily holds back trading activities while the market spread goes higher than the configured 5
pips, but will automatically resume the trading once the market spread drops back to or below the Max Spread
value. This provides a protection against trading during high spread periods like over night or during news or
announcements.

If you do not want trades to take place during high market spread periods then no change is needed. If you trade
a market which has higher spread even during peak of the trading sessions then you may want to adjust the Max
Spread settings accordingly higher.

For more information please refer to the Max Spread for Position Entry page

5.23 Computer Always-on

Question

How to ensure that Windows does not go into sleep or hibernation mode?

How to Turn off Sleep & Hibernation

Ensure that your computer is turned on throughout the FOREX market hours from Monday to Friday, and your
computer is running the MT4 application and the EA is attached to a chart. Simply leave your computer and the
MT4 up and running at all times. Please ensure that your Windows does not go into sleep or hibernation mode:

1. Go to Start > Windows Settings > Power & Sleep

2. Select Never in the dropdown:
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5.24 No Result in Optimization

Issue

After the optimization finished no result is showing in the Optimization Results tab in the Tester

The following message was found in the Tester Journal tab There were X passes done during optimization, X
results have been discarded as insignificant.

Solution

To resolve the "insignificant" issue before you start the optimization you may need to uncheck the Skip Useless
Results in the Optimization Result tab.

1. Click the Optimization Results tab in the Tester.

2. Right click in the empty area for the menu above.

3. Uncheck the Skip Useless Result menu
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4. Rerun the optimization.

5.25 No Trades During Backtesting

Issue

After the backtest finished no trades are showing.

If you see no trades during backtesting then usually it is down to either EA settings issue or MT4 bar history
issue.

Run a Backtest in Visual Mode

In order to see any settings issue with the the theTradeableRSI EA I would suggest to run a backtest in Visual
mode. This would give a chance to see the EA dashboard and any error message in it.

Go to the MT4 Strategy Tester window and tick the Visual mode box:

Tip:  In the event of no Visual mode box is visible then follow the steps in the Visual Mode Checkbox Missing
in Strategy Tester topic.

Do not forget to clear the Optimization box if it was ticked before:
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Now run the backtesting in visual mode: click on the Start button. The Visual mode would make visible any
potential EA messages in the backtesting chart, giving hints for next steps.

Watch out for any red messages in the chart area.

You may find these knowledge based topics useful to resolve them:

• Backtest In Visual Mode Not Working, and
• Backtest Not Working

Check the Bar History Quality

Once no errors are reported in the EA dashboard then you may turn off the visual mode and run the backtest.
Ensure that you use the Every tick mode during the backtest (Settings tab):

And double check that you get 90% modeling quality when you run the backtest (Results tab):

If you get less than 90% then the bar history in your MT4 is not complete for the calendar period you test, and the
test results are not valid.

In this case you could download bar history from MetaQuotes: select in the MT4 menu the Tools > History
Center point, navigate in the symbols tree to the pair you test, double click on the 1 Minute (M1) node for that
pair then click on the Download button:
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Note that the downloaded bar history will be from MetaQuotes, not from your broker. There could be some
differences in the bar history therefore your backtesting results may somewhat differ from your own broker.

Once you downloaded the bar history a good practice is to restart the MT4: exit the MT4, wait 5 seconds then
start it up again.

Now re-run the backtest with Every tick mode and check if you get the 90% modeling quality, and see the
trading results.

5.26 Visual Mode Checkbox Missing in Strategy Tester

Issue

Visual mode checkbox is missing in the Strategy Tester.

Solution

The Strategy Tester window hides some control elements when the window itself is not tall enough, i.e. the
Visual mode checkbox could become hidden. Make the Strategy Tester window taller in order to make all the
control elements visible, like the Visual mode checbox.
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Hover the mouse over the top edge of the Strategy Tester window and drag the edge upwards:

1.

2.

3.

4.

5.

5.27 Step-by-step Installation of Expert4x EAs and Indicators
In this tutorial the name of MetaTrader is used as an example. Replace the MetaTrader with your broker specific
MetaTrader name.

1. Start your MT4 terminal and select the File > Open Data Folder menu
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The menu opens a File Explorer.

2. Close your MT4

3. Check the File Explorer

• If the File Explorer shows a folder like this one below

and you see the origin.txt or the origin file go to the standard installation page.
• If the File Explorer shows a folder like this one below
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and you see the terminal.exe or terminal file go to the non-standard installation page.

5.27.1 Standard EA, Indicator installation
In the opened File Explorer the origin.txt or the origin file was found.

Please follow through the steps below to install the Expert4x EA or Indicator on your MT4

1. Double click the origin.txt file and take a note of the MetaTrader location.

2. Start the EA or indicator setup program. Follow through the setup until you reach the Select Target
MetaTrader Directory window.
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3. In this window select your targeted MetaTrader's Data Folder, as per the origin.txt noted earlier, and click
Next

4. Follow through the rest of the setup application.

5. In the end click Install

6. Check the EA or Indicator in the MetaTrader after installation

a) Start your MetaTrader
b) In the Navigator panel open the Expert Advisors section if you installed an EA or the Indicators

section if you installed an Indicator and look for the EA or Indicator.

5.27.2 Non-standard EA, Indicator installation
In the opened File Explorer the terminal.exe or terminal file was found.

Please follow through the steps below to install the an Expert4x EA or Indicator on your MT4

1. Right click on the name of the Setup application

2. Select Run as administrator (You may get a few security warning or you may need to type in the
Windows administrator password)
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3. Follow through the application until you reach the Select Target MetaTrader Directory window.

4. Click Add target directory... button

5. Navigate to your MetaTrader folder
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and click OK.

6. Scroll down to the end of the list. Select the target directory. Click Next.

7. Follow through the rest of the setup application.

8. In the end click Install
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9. Check the EA or Indicator in the MetaTrader after installation

a) Start your MetaTrader
b) In the Navigator panel open the Expert Advisors section if you installed an EA or the Indicators

section if you installed an Indicator and look for the EA or Indicator.

5.28 How to download an EA setup in VPS environment
In this topic we guide you through the EA setup application download in VPS environment.

1. Start the File Explorer

Click the File Explorer

The File Explorer started.



Knowledgebase

Page 72

2. Select the address bar section

3. Type in: https://my.eafactory.com/expert4x and press Enter to start the Internet Explorer

Did you get blank screen? As you see below:

https://my.eafactory.com/expert4x
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If yes, please select the address bar in the Internet Explorer and type in: https://my.eafactory.com/
UserInterface/index.zul?p=1

If you got this message below you may need to adjust temporary your Internet security settings.

4. When the Web support Site is appeared please log in

5. Select the EA name from the Product List and click Product Download in the Release List

https://my.eafactory.com/UserInterface/index.zul?p=1
https://my.eafactory.com/UserInterface/index.zul?p=1
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If you got this message below you may need to adjust temporary your Internet security settings to enable
downloads.

Warning messages related to the download

• Do you want to save theTradeableRSI EA_v4.0.0_Setup.exe ...?

Click Save to resolve this warning
• If you use Internet Explorer 9.0 you may get this message:

theTradeableRSI EA_v4.0.0_Setup.exe is not commonly downloaded and could harm your
computer

This message is a new features in Internet Explorer 9.0. IE 9.0 has increased user security.

"When you download a program from the Internet, SmartScreen Filter will check the program
against a list of programs that are downloaded by a significant number of other Internet Explorer
users and a list of programs that are known to be unsafe. If the program you're downloading isn't on
either list, SmartScreen Filter will display a warning that the file isn't "commonly downloaded." It
doesn't necessarily mean the website is fraudulent or that the program is malware, but you probably
shouldn't download or install the program unless you trust the website and the publisher."

Source: http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-
questions-IE9?SignedIn=1

These are the steps if you'd like to continue installing the theTradeableRSI EA EA:

 1. Click the Action button in the displayed message
 2. In the dialog box click the down arrow to the left of More options, and click Run anyway

6. After the successful download the Internet Explorer may show this message

To start the installation process after the download click Run

7. Clean up after the download in the Internet Explorer

5.28.1 How to enable JavaScript in your Internet Explorer

Issue

I tried to load the Web Support Centre in the Internet Explorer But the following error message popped up.

http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-questions-IE9?SignedIn=1
http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-questions-IE9?SignedIn=1
https://my.eafactory.com/expert4x
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JavaScripts are disabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

3. Go to the Security tab

4. Select Custom level

https://my.eafactory.com/expert4x
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5. Scroll down until you see Scripting

6. Under the Active scripting select Enable

7. Click OK
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8. Click OK

9. Refresh the https://my.eafactory.com/UserInterface/index.zul?p=1 page ang login

5.28.2 How to Enable Download in your Internet Explorer

Issue

I tried to download the EA setup application in the Internet Explorer But the following error message popped
up.

https://my.eafactory.com/UserInterface/index.zul?p=1
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File download is disabled in the Internet Explorer

To download a file you may need to enable the Download in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

3. Go to the Security tab

4. Select Custom level
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5. Scroll down until you see Downloads

6. Under the File download select Enable

7. Click OK
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8. Click OK

9. click the Product Download button again

5.28.3 Clean up after the download in the Internet Explorer
In this topic we guide you through how to clean up after download in VPS environment.

1. In the Inter Explorer click Tools icon

2. Select Internet options
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3. Go to the Security tab

4. Click the Default level
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5. Click OK
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5.29 How to enable JavaScript in your Internet Explorer

Issue

I tried to load the Web Support Centre in the Internet Explorer But the following error message popped up.

JavaScripts are disabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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3. Go to the Security tab

4. Select Custom level

5. Scroll down until you see Scripting

6. Under the Active scripting select Enable

7. Click OK
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8. Click OK

9. Refresh the https://my.eafactory.com/UserInterface/index.zul?p=1 page ang login

5.30 How to Enable Download in your Internet Explorer

Issue

I tried to download the EA setup application in the Internet Explorer But the following error message popped
up.

https://my.eafactory.com/UserInterface/index.zul?p=1
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File download is disabled in the Internet Explorer

To download a file you may need to enable the Download in the Internet Explorer

1. In the Inter Explorer click Tools icon

2. Select Internet options

3. Go to the Security tab

4. Select Custom level
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5. Scroll down until you see Downloads

6. Under the File download select Enable

7. Click OK



8. Click OK

9. click the Product Download button again
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Chapter

6
 Operational Messages

The theTradeableRSI EA operational messages and resolution guide.

Expert Advisors Operational Messages

Observe the message number displayed in red in the EA dashboard. Find that EA code in the table below and
click on that number to see the details and possible resolutions:

EA Code Severity Message Description

1001 Error

Setup problem: DLL imports not
allowed. Tick Allow DLL imports
in Common tab of the properties
window.

Configuration setting is missing
to allow the EA to use dynamicaly
loaded libraries (DLLs). Enable the
load of DLLs and restart the EA.
More...

1002 Error
Incomplete EA installation: Run
setup application for MT4 instance
"<MT4DataPath>'s Data Folder"

Product installation is not complete or
damaged. Run the setup application
for the MT4 terminal instance as
displayed. More...

1006 Error
MT4 Expert Advisors are disabled:
click AutoTrading icon on MT4
toolbar to execute the EA.

EA does not perform its operations,
not monitoring nor reacting to price
movements of the market. More...

1007 Error
Live trading is not allowed (no smiley
face): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform trading
operations, there is a sad icon in the
top right corner of the chart. More...

1008 Error

Authentication failed or interrupted
(<Stopped>, <Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The EA is not able to authenticate the
user access to the service at its start
up time. More...

1017 Error
Initial risk <InitialRiskPercent>%
is too low. Set EA parameter 'Initial
Risk Percent' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

1018 Error
Initial SL <InitialStopLoss> is too
low. Set EA parameter 'Initial SL for
New Position' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

2118 Error
Service access disabled (<AccessID>,
<ConfirmationID>) - shutting down...

The user quits the authentication
process, or the EA is not able to
authenticate the user access to the
service. More...

9104 Error Order submit failed at bid ...
Broker server rejects orders submitted
by the EA. More...
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MetaTrader Operational Messages

Observe the message number displayed in white in the EA dashboard. Find that MT4 code in the table below and
click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or market
related error. More...

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

132 Error Market is closed.
Market is closed, trading is not
available. More...

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow for
more open or pending orders on the
account. More...

4024 Error Internal error. MT4 terminal internal issue. More...

6.1 Operational Messages
Expert Advisor Operational Messages.

Expert Advisors Operational Messages

Observe the message number displayed in red in the EA dashboard. Find that EA code in the table below and
click on that number to see the details and possible resolutions:

EA Code Severity Message Description

1001 Error

Setup problem: DLL imports not
allowed. Tick Allow DLL imports
in Common tab of the properties
window.

Configuration setting is missing
to allow the EA to use dynamicaly
loaded libraries (DLLs). Enable the
load of DLLs and restart the EA.
More...

1002 Error
Incomplete EA installation: Run
setup application for MT4 instance
"<MT4DataPath>'s Data Folder"

Product installation is not complete or
damaged. Run the setup application
for the MT4 terminal instance as
displayed. More...
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EA Code Severity Message Description

1006 Error
MT4 Expert Advisors are disabled:
click AutoTrading icon on MT4
toolbar to execute the EA.

EA does not perform its operations,
not monitoring nor reacting to price
movements of the market. More...

1007 Error
Live trading is not allowed (no smiley
face): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform trading
operations, there is a sad icon in the
top right corner of the chart. More...

1008 Error

Authentication failed or interrupted
(<Stopped>, <Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The EA is not able to authenticate the
user access to the service at its start
up time. More...

1017 Error
Initial risk <InitialRiskPercent>%
is too low. Set EA parameter 'Initial
Risk Percent' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

1018 Error
Initial SL <InitialStopLoss> is too
low. Set EA parameter 'Initial SL for
New Position' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

2118 Error
Service access disabled (<AccessID>,
<ConfirmationID>) - shutting down...

The user quits the authentication
process, or the EA is not able to
authenticate the user access to the
service. More...

9104 Error Order submit failed at bid ...
Broker server rejects orders submitted
by the EA. More...

6.1.1 Message 1001

Code Severity Message Description

1001 Error

Setup problem: DLL imports not
allowed. Tick Allow DLL imports
in Common tab of the properties
window.

Configuration setting is missing
to allow the EA to use dynamicaly
loaded libraries (DLLs). Enable the
load of DLLs and restart the EA.
More...

Setup problem: DLL imports not allowed

Issue

The EA is not able to start up when gets attached to a chart because some of its dependencies could not be loaded
into memory. The EA requires some dynamically loaded libraries (DLL) to be loaded into memory from disks.
When the EA configuration settings do not allow the load of DLLs then the EA cannot start up and reports this
error message.

Possible root cause

• The EA configuration does not allow for the load of DLLs.

Resolution

Enable the load of DLLs in the EA configuration dialog.

 1. Attach the EA to a chart, or if already attached then select the chart and

• In case of an EA: press F7
• In case of an indicator: press Ctrl+I and double-click the name of the indicator in the list.

 2. Go to the Common tab of the Property window.
 3. Tick the checkbox Allow DLL imports.
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 4. Click OK.

6.1.2 Message 1002

Code Severity Message Description

1002 Error
Incomplete EA installation: Run
setup application for MT4 instance
"<MT4DataPath>'s Data Folder"

Product installation is not complete or
damaged. Run the setup application
for the MT4 terminal instance as
displayed. More...

Incomplete Installation

Issue

The EA is not able to start up when gets attached to a chart because some of its dependencies could not be found
on the file system.

Possible root cause

• The EA setup application was not able to perform all its steps, not completed in full.
• The product was installed manually and some of the steps were missed.
• The MT4 instance's file system got damaged, some files got corrupted or deleted.

Resolution

Download the EA setup application and execute it to get the product installed for the MT4 instance:

 1. Download the setup application from Web Support Centre.
 2. Execute the setup application to get the product installed. For installation guide refer to any of the

following:

• Getting Started with the theTradeableRSI EA
• Step-by-step Installation of Expert4x EAs and Indicators

6.1.3 Message 1006

Code Severity Message Description

1006 Error
MT4 Expert Advisors are disabled:
click AutoTrading icon on MT4
toolbar to execute the EA.

EA does not perform its operations,
not monitoring nor reacting to price
movements of the market. More...

https://my.eafactory.com/expert4x
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EA AutoTrading Disabled

Issue

The EA is not responding to price movements, not performing its logic upon data ticks coming in from the
broker. The MT4 toolbar button AutoTrading is disabled.

Possible root cause

• The AutoTrading button on the MT4 toolbar is disabled.

Resolution

Press the AutoTrading button on the MT4 toolbar.

6.1.4 Message 1007

Code Severity Message Description

1007 Error
Live trading is not allowed (no smiley
face): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform trading
operations, there is a sad icon in the
top right corner of the chart. More...

Live Trading Not Allowed

Issue

The EA is unable to perform trading operations, there is a sad icon in the top right corner of the chart.

Possible root cause

• The Allow live trading checkbox is not ticked at the EA properties window.

Resolution

Enable live trading in the EA properties window.

 1. Go to the chart and press F7.
 2. Go to the Common tab of the Expert properties window.
 3. Tick the checkbox Allow live trading.
 4. Click OK
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6.1.5 Message 1008

Code Severity Message ToDo

1008 Error

Authentication failed or interrupted
(<Stopped>, <Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The EA is not able to authenticate the
user access to the service at its start
up time. More...

Failed Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time and does not start up.

Possible root cause

• The EA could not connect to the authentication server.
• The user quit the authentication process.
• There is a typo in the Access ID entered by the user.
• The theTradeableRSI EA is not yet purchased by the user.
• The theTradeableRSI EA was purchased, but not yet activated by the user.
• The theTradeableRSI EA was purchased or a trial started, but the licensed period (e.g. calendar days) has

lapsed.
• The theTradeableRSI EA was purchased, but the licensed usage limit (e.g. number of parallel accesses) is

breached by the user.

Resolution

Double check the following items to find resolution to the issue.

 1. Ensure that the computer has working Internet connection. For example, go to the Web Support Centre and
see if the page loads with no issues. When the Internet connection is working, restart the EA by pressing F7
and clicking the OK button of the Expert property window.

 2. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save button of the
Service Access Settings authentication window.

https://my.eafactory.com/expert4x
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 3. Ensure you have purchased the product. Log in to the Web Support Centre and select the theTradeableRSI
EA from the product list. If the product is not available for download then it is yet to be purchased at the
Web Support Centre.

 4. Count the number of computers you are running the theTradeableRSI EA on. If it is more than what the
purchased EA licence copies allow then either shut down on the excess number of the computers all the
running theTradeableRSI instances, or purchase more licence at the Web Support Centre.

6.1.6 Message 1017

Code Severity Message Description

1017 Error
Initial risk <InitialRiskPercent>%
is too low. Set EA parameter 'Initial
Risk Percent' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

Missing Initial Risk Percent for Position Sizing Feature

Issue

The position sizing feature is enabled and it requires both the Initial Risk Percent as well as the Initial SL to be set
higher than zero.

Possible root cause

• The Initial Risk Percent is turned off, set to value zero.

Resolution

Set the Initial Risk Percent to higher than zero value.

6.1.7 Message 1018

Code Severity Message Description

1018 Error
Initial SL <InitialStopLoss> is too
low. Set EA parameter 'Initial SL for
New Position' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

Missing Initial SL for Position Sizing Feature

Issue

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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The position sizing feature is enabled and it requires both the Initial Risk Percent as well as the Initial SL to be set
higher than zero.

Possible root cause

• The Initial SL is turned off, set to value zero.

Resolution

Set the Initial SL to higher than zero value.

6.1.8 Message 2118

Code Severity Message ToDo

2118 Error
Service access disabled (<AccessID>,
<ConfirmationID>) - shutting down...

The user quits the authentication
process, or the EA is not able to
authenticate the user access to the
service. More...

Aborted Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time and does not start up.

Possible root cause

• The user quit the authentication process.
• The EA could not connect to the authentication server.
• There is a typo in the Access ID entered by the user.
• The theTradeableRSI EA is not yet purchased by the user.
• The theTradeableRSI EA was purchased, but not yet activated by the user.
• The theTradeableRSI EA was purchased or a trial started, but the licensed period (e.g. calendar days) has

ellapsed.
• The theTradeableRSI EA was purchased, but the licensed usage limit (e.g. number of parallel accesses) is

breached by the user.

Resolution

Double check the following items to find resolution to the issue.

 1. Ensure that the computer has working Internet connection. For example, go to the Web Support Centre and
see if the page loads with no issues. When the Internet connection is working, restart the EA by pressing F7
and clicking the OK button of the Expert property window.

 2. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save button of the
Service Access Settings authentication window.

https://my.eafactory.com/expert4x
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 3. Ensure you have purchased the product. Log in to the Web Support Centre and select the theTradeableRSI
EA from the product list. If the product is not available for download then it is yet to be purchased at the
Web Support Centre.

 4. Count the number of computers you are running the theTradeableRSI EA on. If it is more than what the
purchased EA licence copies allow then either shut down on the excess number of the computers all the
running theTradeableRSI instances, or purchase more licence at the Web Support Centre.

6.1.9 Message 2101

Code Severity Message Description

2101 Error Initialization failed Initialization failed More...

Initialization failed

Issue

The EA dashboard shows that Initialization failed.

Possible root cause

• Your computer slowed down for some reason, and the EA could not start up in a timely manner.
• The EA shut down itself in order to reduce the load on your computer, and allow you to gain back

responsiveness of the computer, so you can free up some resources.

Resolution

Sometimes this can be associated with heavy swap usage by the operating system, which could be caused by
RAM shortage, or cycles of hibernation (close the lid of the laptop). The best way to clean this up is to simply
to reboot your computer: exit the EA, shut your computer down and boot it up again. Do not start up any other
application just the EA and see if the EA can start up now, after the reboot.

6.1.10 Message 9104

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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EA Code Severity Message Description

9104 Error Order submit failed at bid ...
Broker server rejects orders submitted
by the EA. More...

Order submit failed at bid

Issue

The theTradeableRSI EA sends a trading request to the broker server which rejects the request due to an issue
on the broker side. The details of the broker side issue is described by the MT4 error code presented in the EA
dashboard right below the red error message - here is an example:

Possible root cause

In your MT4 chart, observe the MT4 error code displayed in the EA dashboard. Find that MT4 code in the below
table and click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or market
related error. More...

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

132 Error Market is closed.
Market is closed, trading is not
available. More...

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow for
more open or pending orders on the
account. More...

6.2 MetaTrader Operational Messages
MetaTrader Operational Messages.

MetaTrader Operational Messages

Observe the message number displayed in white in the EA dashboard. Find that MT4 code in the table below and
click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or market
related error. More...
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MT4 Code Severity Message Description

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

132 Error Market is closed.
Market is closed, trading is not
available. More...

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow for
more open or pending orders on the
account. More...

4024 Error Internal error. MT4 terminal internal issue. More...

6.2.1 MT4 Message 2

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or market
related error. More...

MT4 Message: Common error

Issue

The EA dashboard shows that there is a 'common error' on the MT4 level which blocks the communication or
trading with the broker server. This may occur after a lost connection over the Internet to the broker server where
the reconnection did not succeed properly, or due to some other account or market related issue.

Resolution

Restart your MT4: In the MT4 menu select File > Exit, wait 5 seconds then start it up again. Hopefully the EA
'code 2, common error' would get cleared and the MT4 would be able to operate fully again.

When the demo broker account expires this message may turn up. In this case create a new demo account with the
broker.

6.2.2 MT4 Message 129
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MT4 Code Severity Message Description

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

MT4 Message: Invalid price

Issue

The EA dashboard shows that the order failed because of the market price moved on by the time the order
reached the broker, which can happen in trading on a daily basis.

Resolution

In this case the EA automatically sends a new order according to the new market price and recovers from this
issue on its own.

Watch out for the 'Count:' figure at the end of the red error message. Only if the Count figure would keep
increasing every few seconds or so for longer than 5 - 10 minutes then a closer look would be needed. That
could be an indication of a permanent issue which may need investigation and intervention. In this case send a
screenshot of the chart showing the EA dashboard including the error message in full to support.

6.2.3 MT4 Message 132

MT4 Code Severity Message Description

132 Error Market is closed.
Market is closed, trading is not
available. More...

MT4 Message: Market is closed

Issue

The EA dashboard shows that the root cause of the issue was that the broker closed the trading of the market at
around midnight GMT broker time.

Resolution

This is probably due to the practice the broker switches liquidity providers (banks) at around midnight GMT
when the EU/US session ends and the Asian session kicks in. The switchover period could be just a few minutes
but may last up to an hour or so around midnight GMT. As the Count: figure is increasing only over this short
switchover period this is only a temporary issue.

The EA automatically recovers from this situation on its own and sends new orders to the broker when the market
becomes open for trading again.

Watch out for the 'Count:' figure at the end of the red error message. If the Count figure increases only during the
midnight GMT switchover period then no further action or intervention is needed. However, if the Count figure
would keep increasing at any time of the day (not only around midnight GMT) every few seconds or so for longer
than 5 - 10 minutes then a closer look would be needed. That could be an indication of a permanent issue which
may need investigation and intervention. In this case send a screenshot of the chart showing the EA dashboard
including the error message in full to support.
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6.2.4 MT4 Message 133

MT4 Code Severity Message Description

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

MetaTrader Message: Trade is disabled

Issue

The theTradeableRSI EA got attached to a chart, the EA is up and running. It keeps submitting market orders to
the broker server. However, the broker's server does not execute these market orders, instead, the broker says the
trade on this broker account is disabled:

The broker server reports the MT4 error code 133, which means that the trade is disabled on the account. This
is not an EA issue, instead, this is an issue with the broker account. For some reason the broker account does not
allow you to trade that market.

Resolution

Go through the following checklist to resolve this issue:

 1. Restart the MT4 terminal to see if the restart and reconnect to the broker resolves this: In the MT4 menu
select File > Exit, wait 5 seconds then start the MT4 up again.

 2. Identify another symbol for the same market which is enabled for trading: In the MT4 menu select View >
Symbols and search for symbol with different/extra suffix in the name, like EURUSDecn. Add that symbol
to the Market Watch window then attach the EA to this new symbol.

 3. Logging into your MT4 broker account with the investor login credentials disables trading. Ensure that you
log in to your broker account with the full trader login credentials.

 4. Create another demo account with the broker.
 5. Contact your broker and ask their support team to enable trading on the symbol or account

 1. Your broker account may have reached some trade limits (e.g. overall maximum lots).
 2. Your broker may have put (temporarily) trading limitations on your account for some reason.
 3. Your broker may have to enable trading by EAs.

6.2.5 MT4 Message 136

MT4 Code Severity Message Description

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

MT4 Message: Off quotes

Issue

The EA dashboard shows that the order failed because of the current market prices are not available due to
connectivity issues, or because some of the broker constraints got breached by the order, like quotes got outdated
or moved too far away.
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Resolution

The EA automatically sends a new order according to the new market conditions and recovers from this issue on
its own. There is no need for any intervention.

6.2.6 MT4 Message 148

MT4 Code Severity Message Description

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow for
more open or pending orders on the
account. More...

MT4 Message: Amount of open and pending orders has reached the limit

Issue

Based on the MT4 error code 148 the number of open trades reached the limit of the broker account, i.e. there are
too many open trades on the account and no more trade can be entered. This is a broker account limitation, not an
EA limitation.

Resolution

The number of open trades needs to be reduced on the broker account. If you run multiple EAs on the account
then close some of those charts with the EAs and close the corresponding trades off. You may consider to open
another broker account and start those EAs up on that new broker account.

You could also limit the number of trades this EA can open on the account - see the

6.2.7 MT4 Message 4024

MT4 Code Severity Message Description

4024 Error Internal error. MT4 terminal internal issue. More...

MT4 Message: Internal error

Issue

The MT4 Expert tab shows that there is a 'internal error' in the MT4.

The 4024 comes up when the MT4 is busy, and some request from the EA, like to refresh the chart area, cannot
be processed without delay. This is an internal issue to the MT4 due to a busy or overloaded environment. The
impact of this issue is that the chart area may get refreshed with some delay. However, in extreme cases this may
become an issue impacting the trading as well.

Resolution
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If you get this 4024 only occasionally, a couple of times a day then you may ignore this message. However,
if you get this message very regularly, then your MT4 or computer could be overloaded or its performance
degraded. In this case exit your MT4, reboot your computer, and only start the MT4 up and no other applications
which you do not use. If you still get 4024 messages then close some of the charts, detach some of the EAs in
your MT4. This is to reduce the load on your computer and to eliminate this message.
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7
 Support

Please contact support@eafactory.com if you require any further assistance. Please copy info@expert4x.com on
your email.

mailto:support@eafactory.com?cc=info@expert4x.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
mailto:info@expert4x.com?cc=support@eafactory.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
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